
Cornell University Press Guidelines for Line Art Maps

Purpose
1.	 The purpose of this document is to provide authors with guidelines to share with cartographers 

whom they hire to produce line art maps for standard grayscale (i.e., black and white) printing in 
Cornell University Press books. Cornell strongly recommends that all line art maps be prepared 
by professional cartographers; your acquisitions contact can provide names of recommended 
map makers.

2.	 Authors are expected to submit editable production-ready maps at the start of the publication 
process. Line up your map maker early and have it ready to submit along with your manuscript 
and art program.

3.	 These guidelines do not apply to the following map types: historical, archival, or digital maps 
provided fully as hi-res images or color maps for science or art publications.

4.	 This document is a complement to our Guidelines for Submitting Illustrations, available at 
https://www.cornellpress.cornell.edu/about/#about=for_authors, which defines some of the 
terms and file types referred to in this document.

File Format
1.	 We request that all maps for which these guidelines apply be submitted as a readable Adobe 

Illustrator .eps file with fonts embedded. Files created in Illustrator and exported as .eps are 
vector graphics and can be resized as needed without any loss in resolution.

2.	 If a map is a raster file or scan (as is the case with most historical maps), it can be submitted 
as a hi-res tiff file and be evaluated by the criteria available in our Guidelines for Submitting 
Illustrations.

3.	 If the map was made with, or includes embedded raster layers from, a mapping or Geographic 
Information System (GIS) software, the raster image or layer of the map should be exported 
from the native software following the same color mode and resolution guidelines as other 
grayscale art and be evaluated by the criteria available in our Guidelines for Submitting 
Illustrations. (Please note, any text or features contained in a raster image or layer are not 
editable by CUP, and the cartographer must be available to make any needed changes that 
arise during the production process. Authors are responsible for trafficking such revisions.)

File Color Mode
1.	 Submit files with a color setting of CMYK not RGB. CMYK is the color mode intended for 

printing with ink, the method for printing books. RGB is the color mode intended for screen 
or digital displays and is not suitable for printing books.

2.	 Be sure your CMYK file is prepared and submitted as grayscale only, with all color in values of 
K (black ink). To ensure that all color is composed of only values of K, first verify the color mode 
in Illustrator following this path: File > Document Color Mode > and verify CMYK is checked. 
Next, check that all colors are values of only K. Open the Print swatches panel in Illustrator 
(Window > Swatch Libraries > Default Swatches > Print). Refer to the row of swatches near 



the bottom of the panel that range from 5K to 100K with various grays in between. These are 
K-only grayscale swatches. Select an object in the map; if the object is gray but does not match 
one of these swatches, it may be a gray composed of more than just black ink. To remedy, 
switch the object’s color to one of the grayscale swatches or set a new grayscale swatch as 
described in #3 below.

3.	 To set values of K in a grayscale CMYK document, open the Swatch panel (Window > Swatches) 
and select New Swatch. Select CMYK color mode, then toggle the K value for the desired 
percentage of gray, following our shading guidelines below. All other values—C, M, and Y— 
must be set at zero percent.

4.	 If a raster image is used as a layer, for example to add topographic features, before placing 
the image in Illustrator it also needs to be in the proper color mode and must be saved in 
Adobe Photoshop as a grayscale rather than color image before exporting. In Photoshop, 
follow this path to set the color mode correctly: Image > Mode > Grayscale. Remember, as 
noted above, the raster image, before placing it in Illustrator, must also be saved in Photoshop 
at a minimum of 300 dpi at the size it is intended to appear in the printed book.

How to tell a vector image from a raster image
The easiest method to do this is to open the file in Preview, Acrobat, or Illustrator 
and magnify the image. At a high magnification, it is quickly apparent whether 
the edges of the shapes and lines retain their sharpness (indicating they are a 
vector image and will be suitable for printing) or have a blurry or pixelated edge 
to them (indicating they are a raster image and will be unsuitable).      

vector image	 raster image

Size
For 6” x 9” trim books, the recommended map dimension is 4.5” x 7.5” with the map 
oriented either horizontally or vertically as it best suits the content. Most CUP books have 
a trim size of 6” x 9” but authors should check with their acquiring editor for confirmation. 
It is important to tell your cartographer the maximum dimensions of the book page and 
have them create the map to function at these dimensions. We strongly recommend that 
maps be submitted sized as they’re intended to appear on the printed book page. This 
removes the guesswork as to the weight of the strokes and the type sizes, helps determine 
the general legibility of the map’s details, and makes it easier for CUP to spot problems 
and provide detailed feedback to the cartographer if revisions are required. For a visual  
of the recommended dimension, see the Appendix to this document.



Typeface
•	 Ideally, use one font size for all type throughout the map. If you must use varying sizes, 

they should vary from each other with slight rather than extreme proportions (one point 
size difference is usually sufficient). See the Appendix for more on this.

•	 Ideally use a type size of 7–10 point in a recommended font.

•	 Use a single font only, and one that is easy to read; a sans serif font performs best. Examples 
include Aksidenz Grotesk, Arial, Avenir, Helvetica, Helvetica Neue, and Myriad Pro.

•	 Be sparing in the use of font styles (bold, italics, tracking, or underlining). In most cases, 
such styles are unnecessary and can be distracting.

•	 Avoid ALL CAPS, as this decreases overall legibility.

•	 Avoid running text over lines such as borders or other map features.

•	 Do not run text over text.

•	 Leave enough spacing between discrete labels to allow for legibility.

Line Weight
One consistent line weight is preferred. Rules should be no smaller than .5 pt and no larger 
than ~2 pt, depending on the size of the map and the level of detail.

Shading
•	 Always use 100% black (100K) for text.

•	 Avoid minor variations in shading, which can look fine on-screen but lose distinction in the 
printed book. Values of 20%, 50%, and 80% black are usually sufficiently distinguishable 
from one another and from solid white and black.

•	 Avoid drop-out type (labels that on-screen appear white on a shaded background), which 
does not tend to hold its legibility once printed.

•	 When using patterns in addition to shading keep the pattern style simple (diagonal lines, 
dot patterns, etc.).

•	 If a map key is included, be sure the shading or pattern icons are large enough to clearly 
identify the shade or pattern once the map is sized down to its printing size.

•	 When placing text over shaded areas of maps never place the type on fields over 30K.
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Summary
The cartographer should strive to create all labels, lines, icons, numbers, and additional 
features with the primary purpose of clearly conveying information. Whether adding icons, 
a compass, a “north” arrow, or some other feature, function should always precede form. 
A simple compass or icon will covey its meaning much more effectively than an ornate 
illustration or an overly detailed icon that may look impressive when magnified but will 
convey no added meaning when displayed at its intended size, usually the size of a text 
character.

When determining whether a map will reproduce as intended when printed it is important 
to account for the depreciation of the image between on-screen and on paper once printed 
on various printing presses, both offset and digital and on different stocks of paper. Follow 
these guidelines in preparing all line art maps, and as a final check the cartographer should 
always print out the map at the size at which it will be printed in the book, and adjust it 
as needed to achieve successful results.

When in doubt, print it out! 



APPENDIX
This appendix contains an example of successful map making for print publication along with examples 
of common problems and recommendations for avoiding them.

Example of Successful Map Making
Line weight
One uniform stroke weight is used throughout to define the land masses. A slightly thicker stroke is 
used to define the enlarged map border.

Type
Although the map has a variety of type sizes, the sizes are relatively close in point size; a hierarchy 
is achieved without losing legibility. Type has been placed over a shaded field on the map, but the 
shaded area is 20K, below the maximum shading threshold for placing type. Most of the type is in 
Title Case, which makes it easier to read, especially the type designating the larger cities (with the 
longer names) on the enlarged map.

Shading
This is an elegant map. The text is easy to read throughout, and the field beneath the text is all 30K 
or less.
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Issues: Type- Serifed Font and Font Styles
•	 The map above uses serif fonts, which we do not recommend. We prefer sans serif fonts that don’t 

have styling embellishments that can lower legibility. Not only do sans serif fonts have a cleaner look, 
but at smaller sizes they have a lower likelihood of the characters filling in on press.

•	 Font styling: As with type sizing, we recommend a more subtle approach to styling over the styles used 
above. A plain roman font styling with subtle sizing changes works better than using italic, semi-bold, 
bold, etc. Not only can over styling give a blotchy, aesthetically displeasing look to the map, but it also 
presents further legibility and printing issues, increasing the likelihood of characters filling in on press.
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Issues: Fills
•	 The map above shows poor use of shading. The most common problem we see is type placed on 

dark gray fills (fills over 30K). Gray at 30K and below is safe for 100K type. (Remember, all type on 
maps should be at 100K.) Whenever possible, strive to have as few shades as possible and to avoid 
them in areas that will feature type.

•	 The differences in shades should be great enough for the each shade to be discernible in print. The 
differences in grays of 0/20/50/80/100K should be great enough to be apparent to the reader.

•	 Drop-out type should be avoided. Although the type may look clear and legible on-screen, the type 
will fill in somewhat on press; furthermore, the paper used to print the majority of books is a cream 
color, which further reduces the legibility of drop-out type.



Issues: Line Weight
The map above shows the pitfalls of inappropriate line weights. It’s easy to see how adjusting the 
weight of the stroke can turn a clean, elegant map into one that looks clunky. Although the stroke has 
been adjusted to 2 pt, which in many cases would be considered toward the top end of our tolerance, 
in this case, it does not work well because the fine detail of the various bays and definition of the small 
island are lost as the stroke begins to resemble blotches with thick, rough lines.
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Issues: Type Sizing
The map above shows unnecessary variations in type point size. Although cartographers may use 
type size to draw emphasis to a particular region or to show a hierarchy of political or geographical 
importance, it’s not necessary to show a variance in type that is directly correlated to every level of this 
hierarchy. For example, a village/town/city/state hierarchy does not have to be represented directly 
by an increase in point size for each level. In most cases village/town/city/ can be one point size, and 
if necessary, state a different point size. Also, as you can see by this example when comparing it with 
the first example in the appendix, slight differences in size are more effective than larger, seemingly 
arbitrary ones.



Issues: Patterned Fills
The map above shows how not to use pattern fills! Some experienced cartographers may use patterns 
elegantly, but not all cartographers may be aware of issues that their style choices may face in print. The 
most obvious issue is the decreased legibility of the type in a patterned area. The lines of delineation 
can become mottled, and the various patterns, as in this case, may even induce visual dissonance (or 
headaches!). Instead of pattern fills, opt for approved shading levels that adhere to the guidelines 
in this document.
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Blue= max area 5x 8

Yellow = recommended 4.5 x 7.5

Yellow = recommended 4.5” x 7.5”

White = Entire page 6” x 9”

Blue = max area 5” x 8”

Issues: Map Dimensions
Cartographers produce a wide variety of maps, and although most of their work is done in programs 
that can easily scale up or down the map dimensions as needed, if they are given the proper page 
dimensions before they begin their process it will help inform their decisions for type size, line weight, 
whether the map will be landscape or portrait orientation, and how much detail they should include. 
What follows is the layout for a typical 6” x 9” page, showing both the recommended space (yellow) 
for maps (or other illustrations) and the maximum space allowable (blue) on the page. Remember 
that the map title will need to fit on the page beneath the map in the blue area as a caption (never 
include the map title in the map itself).



Map File Checklist (complete for each map submitted)

	� This map was drawn by a professional cartographer.

	� The line art map guidelines have been fully reviewed.

	� This is a line art map drawn in a vector-based drawing application such as Adobe 
Illustrator and exported as an .eps file.

	� The color mode has been set as CMYK not RGB.

	� All shadings are in values of only K, with values of C, M, and Y set at zero.

	� All text is 100K (100% black).

	� The map contains no color.

	� Any shadings in the map are sufficiently distinguishable from one another, such as in 
values of 20%, 50%, and 80%.

	� Pattern fills, if used, have been used with discretion.

	� Any raster layers or images included as map features have been exported at 300 dpi 
and grayscale color mode before placing in Illustrator.

	� This map has not been artificially made to be an .eps file by taking a raster (pixel based) 
image file and saving it in Illustrator.

	� Text has been prepared in one of the following san serif fonts: Aksidenz Grotesk, Arial, 
Avenir, Helvetica, Helvetica Neue, or Myriad Pro.

	� Font sizes vary only slightly, and with purpose

	� Font styles such as italic, bold, or all caps are avoided or used sparingly.

	� All fonts are embedded and the cartographer can legally share them.

	� Text is not run over lines.

	� Text is not run over text.

	� Text has not been set on areas with shading levels above 30K.

	� Drop out type has not been used.

	� One consistent line weight is used and lines are no smaller than .5 pt and no larger 
than 2 pt.

	� The planned book trim has been verified at 6” x 9”, and the map dimensions at 100% 
size measure 4.5” x 7.5” for full page maps and 4.5” x 3.25” for half-page maps.

	� The book trim has been verified at another dimension and the map at 100% has been 
sized according to CUP instructions.

	� The title of the map has not been included in the map itself.

	� Icons, markers, and symbols are sized appropriately and avoid unnecessary detail or 
ornate design that will become problematic in printing.

Additional comments:
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